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Instruction Sheet Learning Guide #66 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 

 OHS requirements regarding computer use  

 Consulting Designated personnel for operating computer system 

 Identifying System or operational problems and notifying relevant 

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 OHS requirements regarding computer use  

 Consult  Designated personnel for operating computer system 

 Identify System or operational problems and notifying relevant 

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2and Sheet 3”. 

4. Accomplish the “Self-check 1, Self-check t 2 and Self-check 3” in page -12, 14 and 16 

respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation Sheet 

1,” in page -17. 

6. Do the “LAP test” in page – 17 (if you are ready).  
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Information Sheet-1 

 

  OHS requirements regarding computer use  

 

 

1.1 OHS requirements regarding computer use  

       Introduction  

OHS guidelines related to the use of the display screen equipment (DSE) 

Working with computers can cause workers a number of problems. These include stress, 

visual discomfort, as well as aches and pains in the hands, wrists, arms or shoulders. The 

main health risks that arise from work with display screen equipment are fatigue, eye strain, 

upper limb problems and backache. These problems can arise from overuse of display 

screen equipment or improper use, for example where a workstation is not set up properly for 

the user. Every organization should have a Guideline for using computers - preventing and 

managing discomfort, pain and injury of workers. These Regulations only apply to employers 

whose workers regularly use DSE as a significant part of their normal work (daily, for 

continuous periods of an hour or more). These workers are known as DSE users. These 

Regulations do not apply to workers who use DSE infrequently or for short periods of time. 

However, the controls described in ‘How to control the risk’ may still be useful for these 

workers. If you have DSE users, you must:  

 analyze workstations to assess and reduce risks 

 make sure controls are in place 

 Provide information and training  

 Provide eye and eyesight tests on request, and special spectacles if needed 

 Review the assessment when the user or DSE changes. For those who employ many 

users of DSE, this guidance also contains information that may help you manage your 

legal duties efficiently. 
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   1.1.1 Ensuring work organization 

There are a number of factors involved in ensuring your work organization. These involve exercise 

breaks, mix of repetitive and other activity, rest period and visual displaying unit eye test. Those 

activities are important to create an ideal environment, which enhances comfort and productivity. 

                 1.1.1.1 Exercise breaks 

There is no requirement under OHS legislation to provide specific breaks to computer/VDU 

users. During breaks, the eyes should refocus at a variety of distances, and expansive movements 

that exercise different muscle groups in the neck, shoulders, arms, hands, and fingers, will help to 

relieve muscular fatigue. 

1.1.2 Mix of repetitive and other activities 

Unfortunately, much work done on computers requires some repetitive motions. Physically using a 

computer (typing, clicking the mouse) is very repetitive. Completing the same physical movements 

day-in, day-out can lead to issues such as occupational overuse syndrome (OOS) or repetitive strain 

injury (RSI). These issues can cause severe pain and discomfort in the muscles or joints in areas of 

the body that complete these repetitive tasks. Designing work rosters and time allocations that allow 

workers to complete different tasks can reduce this level of repetitiveness in the workplace, therefore 

reducing the risk of workers developing these problems. Workers can often feel mentally refreshed 

and become more productive if they have some variety in their work during the day. 

1.1.3 Rest periods 

Rest or work breaks can range from short pauses to defined breaks such as lunch. Answering the 

phone or collecting a document from the printer are short breaks that provide different movements. 

They are an opportunity for muscles that have been active in computer use to rest and recover.  

Job design for screen based work should make provision for regular breaks of at least 15 minutes per 

hour for concentrated screen based work, and 15 minutes per 2 hours for less strenuous work. 

1.1.4 Visual display unit (VDU) eye testing 

No evidence that visual display units (VDU‟s) can cause disease or permanent damage to eyes. 

However extended or prolonged periods of VDU work can lead to tired eyes and discomfort. As the 

eyes now perform more demanding tasks, it may make VDU workers more aware of an eyesight 
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problem. It may also make those with pre-existing vision defects more aware of them if these are not 

corrected 

Computer vision syndrome is also a common eye condition amongst VDU users. Symptoms can 

range from tired eyes to blurred vision. Eye testing should be conducted at frequent interval 

Step 1: Adjust Your Chair 

Set Seat Base Tilt 

* Note - not all office chairs have a seat base tilt feature.  

• Adjust the seat base so that it tilts slightly forward.  

• It should be tilted enough to cause the person to sit in a more upright position and promote 

a downward slope of the thighs. 

• Tilting the seat base in combination with setting the backrest allows the person to sit right 

back in the chair and gain the necessary support. Set Backrest Height 

• Move the backrest to locate the lumbar support to the curve in your lower back (not the 

upper buttocks). This generally means that the „plumpest‟ section of the backrest fits into the 

small of your back. 

• Lock the backrest into place. Set the Backrest Angle 

* Note - not all office chairs have an angle adjustable backrest.  

• Use your body weight to lean back against the backrest. Depress the control lever to enable 

the backrest to change angle. 

• Adjust the angle to allow normal upright alignment of the spine. Try to maintain the three 

natural curves. 

• Provide a full support to your back when doing computer work. 

• Use the chair backrest to provide different postures e.g. angle back when chatting on the 

phone, talking to visitors and reading. 

Note: Frequent posture changes encourage blood flow in different muscle groups which 

helps minimize back fatigue when sitting for prolonged periods.  
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      Set the Seat Height 

 Option One: With a non adjustable desk 

• Raise / lower the seat to enable the desk height to be at your elbow height. 

• There should be a slight downward slope of the forearms and you should be able to reach 

the key board without your elbows leaving the side of your body 

Note:  

• If you are a “touch typist” you may sit slightly higher. 

• If you are not a touch typist, you may sit slightly lower than elbow height. This helps relieve 

neck fatigue as you frequently look between the keyboard and monitor. 

Footrests 

Microsoft Office Word 2007 includes many predesigned headers or footers that you can 

insert into your document. Or you can create a header or footer from scratch. 

 See information later in this article for steps to include the following popular items in the 

header or footer: 

• Use a foot rest if you feel pressure under your thighs from the front edge of the seat or if 

your feet do not touch the ground. 

• Ensure there is a slight downward slope of the thighs to promote blood flow. 

Note: If you find yourself slumping in the chair (so as to get your feet to rest comfortably on 

the ground), you need to consider a footrest.  

In these situations, pushing your feet into the footrest helps to push your back into the angled 

backrest of the chair.  

 Option Two: With an adjustable height desk 

• Lower your chair seat to rest your feet on the floor and relieve any pressure on the 

underside of your thighs from the front edge of the chair. 

• Lower the desk height to your elbow height when you are seated on the chair. 
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• See Notes from Option One. 

• If your keyboard shelf adjusts separately from the desk, be careful not to create a height 

difference between your keyboard and mouse.  This may create a “mouse shoulder” problem 

by frequently elevating your arm to use the mouse. 

• If you prefer to use the keyboard shelf, ensure it is big enough to accommodate the mouse 

as well. 

• If “mouse shoulder” is of concern, raise the keyboard to the height of the fixed desk, then 

follow guidance in Option One.  

Step 2: Position your Keyboard and Mouse 

Both these items are used frequently and are to be located on the desk in the primary reach 

envelope. 

Keyboard 

A keyboard is the most common input device. Several kinds of keyboards are available, but they 

resemble each other with minor variations. Generally standard keyboard has 104 keys.  

The keys are often classified as follows:  

 Alphanumeric keys – letters and numbers  

 Punctuation keys – comma, full- stop, semicolon, etc.  

 Special keys – function keys, control keys arrow keys, cap lock keys, etc. 

 

• Touch typists should locate the keyboard close to the desk edge. 

• Non touch typists should locate the keyboard around 10cm in from the desk edge.  
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This enables: 

- Desk space to rest the hands when not typing 

- Reduced neck angle when looking between the keyboard and monitor 

• A further option locates the keyboard nearly a forearm length from the desk edge. This 

enables the forearms to rest on the desk when not typing and they glide over the desk when 

typing. 

• The mouse can go on the left or right side, whichever is preferred. 

Note: 

• Check that your typing technique does not involve: 

- Subtle elevation of your shoulders 

- holding your hands up with bent wrists 

- resting your wrists on the desk and angling your wrists 

- “wrist rests” are generally not required with the modern slim line keyboards and generally 

not recommended for a standard workstation setup. However, some users find that “wrist 

rests” do eliminate the typing technique (bent wrists). In these cases, they are a benefit.  
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Mouse 

A mouse is a small device with buttons on the top (see the left figure below) and a ball on the 

bottom (see the right figure below). As you move the mouse across a surface (such as a 

mouse pad), a pointer on the screen moves in a way which corresponds to the direction and 

speed the mouse was moved.  

One major innovation in mouse buttons is the scroll wheel: a small wheel, which can be 

rotated as shown 
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• The elbow should remain bent when reaching for the mouse. The mouse should be located 

in the primary reach envelope (inner reach). 

• Your forearm should rest on the desk when your hand is on the mouse. It should glide over 

the desk when using the mouse. 

Note: 

Your wrist should not be the contact point between your arm and desk when using the 

mouse. 

• Try to train yourself to use the mouse with either hand. 

• Learn keyboard shortcuts for frequent mouse activities and reduce your use of the mouse. 

• When mainly using the mouse, locate it directly in front of you and use your other hand for 

minor keyboard corrections. 

• Do not continue to grip the mouse when it is not in use. Do not “hover” your hand over the 

mouse, rest your hand on the mouse or desk. 

Note: 

“Wrist rests” with a mouse also eliminate poor technique but are generally not required/ 

recommended for standard workstation setup.  

       Step 3: Position your Computer Monitor 

Option One: Conventional monitor 

If you have a conventional monitor. 

• locate it at the apex of an L shaped desk parallel with the keyboard location. 

• Alternatively, locate it on either side surface of the desk or on a rectangular desk.  

• Elevate the monitor until the top of the picture tube is approximately the same height as your seated 

eye height. 

• Push the monitor back until the face of the monitor is at least full arms length away from your seated 

position.  

Option Two: Laptop 

If you use a laptop for more than 2 hours per day, you should: 

• Either, locate the laptop on a stand to elevate the screen to eye height. Use a separate keyboard 

and mouse. 

• Or, use the laptop keyboard, separate mouse, and a separate, elevated conventional monitor. 
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• Or, use a full docking station to create Option One arrangements 

 

 

• If you are not a touch typist, place document on angled surface behind the keyboard and in front of 

the monitor stand. 

• If you are a touch typist you may prefer an alternative document stand elevated to either side of the 

monitor 

Step 5: Position of Telephone 

STEP 4.position documents used with the computer  

• Consider locating the telephone on your non dominant side of the computer. However, do not reach 

across your body to answer the phone, use your non dominant hand. 

• If it is frequently used, locate it in the primary reach envelope (inner reach). 

• If you have frequent or prolonged telephone calls or are required type while conversing on the 

phone, consider using a headset when accessing computer data.  

Step 6.safe work practice  

• Remember your muscles need regular movement to generate a good blood flow.  Sitting for long 

periods is not good for your health. 

• Change postures frequently and stand up preferably every 30 minutes. 

• Short breaks more often are better for your body than longer breaks less often. 10 minutes in every 

hour should be spent doing a task that involves a different posture (Task rotation) 

• “Listen to your body”. If your muscles are feeling fatigued, stop the activity and stretch. This 

generates blood flow and avoids a buildup of fatigue. 

• Remember, your muscles tense when you are feeling stressed and can also feel fatigued.  Take 

control of your activities to avoid the stress factors that produce muscle fatigue.  
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below.  

1. Working with computers can cause workers a number of problems. These 

include stress all. Except? 

A. Visual discomfort 

B. Aches and pains in the hands,  

C. Aches and pains in wrists, and arms  

D. Pleasure  

2. The main health risks that arise from work with display screen equipment are: 

A. Fatigue 

B. Eye strain  

C. Upper limb problems and backache 

D. All of the above 

3. If you have DSE users, you must do the following except? 

A. analyze workstations to assess and reduce risks 

B. no need of making controls in place 

C. Provide information and training on   

D. Provide eye and eyesight tests on request, and special spectacles if needed 

4. Identify factors which are not involved in ensuring work organization? 

A. Exercise break  

B. Rest period 

C. Visual displaying unit eye testing 

D. Work under stress  
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Information Sheet- 2 
Consulting Designated personnel for operating computer 

system 

 

1.2 Consulting Designated personnel for operating computer system 

Consultants should make sure that their computers have effective and licensed virus 

detection and cleaning application, to protect the information on their computer as well as 

documents passed within the ADB. Computers without such software will not be allowed to 

connect to the ADB’s network. 

 Consultants should make sure that they have installed all necessary operating 

systems security patches on their computers, including updates issued during the 

engagement period. 

 When required, OIST provides consultants with access to e-mail (internal and 

external), ADB’s application systems, and/or the Internet. This normally applies to 

consultants working in the headquarters for periods of more than one month, or to 

consultants with a specific need for such access as described in their terms of 

reference. OIST does not provide dial up connections using the ADB’s telephone 

system. 

 

 

 The computer operated to carry-out different work activities. 

 To operate the computer effectively and properly the operator should well 

understanding about the computer operation. 

 The operator should ask/consult the professional personnel about how to operate the 

computer before he start the operation. 
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below.  

1. Operating computer system Consultants should make sure all of the following 

except?( 5 points) 

A) computers  must have effective and licensed virus detection  

B) protect the information on their computer as well as documents  

C) computers  must have effective cleaning application  

D) Provide eye and eyesight tests on request, and special spectacles if needed 

 

 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2.5-5 points    Unsatisfactory - below 2.5 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-3 Identifying System or operational problems and notifying 

relevant personnel 

 

1.3 Identifying System or operational problems and notifying relevant personnel     

    Why identify and report the problems for relevant personnel? 

 To find the solution for problems.  

 To report about the problem to the relevant persons to maintain/adjust the problems.  
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below.  

1. Why do we identify and report the problems for relevant personnel? (5 points) 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2.5 and 5 points            Unsatisfactory - below 2.5 points  

You can ask you teacher for the copy of the correct answers. 
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Operation sheet-1 

 

OHS requirements regarding computer use  

 

Producers  

Step 1: Adjust Your Chair 

Step 2: Position your Keyboard and Mouse 

Step 3: Position your Computer Monitor 

Step 4: Position Documents Used with the Computer 

Step 5: Position of Telephone 

Step 6: safe work practice  
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Plumbing Installation Work 

LEVEL II 

                        Learning Guide # 67 

Unit of Competence: use computerized system 

 Module Title:  using computerized system 

LG Code:  EISPLI2 M14 Lo1- LG 67 

TTLM Code:   EISPLI2TTLM14 0919 v1 

LO2. Use computer systems to access, enter and 

retrieve workplace information 
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Instruction Sheet Learning Guide # 67 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics:  

 Locating, operating and  using relevant workplace information  

 Entering relevant workplace data  

 Producing Basic reports  

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 Locate operating and  using relevant workplace information  

 Enter relevant workplace data  

 Produce  Basic reports 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3and Sheet 3”. 

4. Accomplish the “Self-check 1, Self-check t 2 and Self-check 3” in page -27, 36 and 41 

respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation Sheet 

1 and Operation Sheet 2” in page -42 and 43. 

6. Do the “LAP test” in page – 43  (if you are ready).  
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Information Sheet-2 

 

Locating, operating and  using relevant workplace 

information  

 

 

2.1 Opening and designing DB application and principles 

2.1.1 Database  

A database can best be described as a way of storing large amounts of information. The 

data can be retrieved and we can even ask questions of the data and get answers. For 

example: You may want to know how many Students enrolled in every occupational 

level. 

 

Ms Access is a database management tool that enables one to store relevant 

data.  This also has the capabilities to retrieve, sort, summarize and report 

results immediately and effectively. It can combine data from various files 

(tables) through creating relationships, and can make data entry more efficient 

and accurate through the use of forms. 

Microsoft Access (MS Access) enables one to manage all important information from a 

single database file.  Within the file, one can use the different objects: 

 Tables - A table is a collection of data about a specific topic, such as products or 
suppliers. Using a separate table for each topic means that you store that data only 
once. This results in a more efficient database and fewer data-entry errors. 

 Queries - You use queries to view, change, and analyze data in different ways. You 
can also use them as a source of records for forms, reports, and data access pages. 

 Forms - A form is a type of a database object that is primarily used to enter or display 
data in a database. You can also use a form as a switchboard that opens other forms 
and reports in the database, or as a custom dialog box that accepts user input and 
carries out an action based on the input.  

 Reports - A report is an effective way to present your data in a printed format. 
Because you have control over the size and appearance of everything on a report, 
you can display the information the way you want to see it 

 Modules - A module is essentially a collection of declarations, statements, and 
procedures stored together as one named unit to organize your Microsoft Visual Basic 
code. Microsoft Access has two types of modules: standard modules and class 
modules. 

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconModulesWhatTheyAreHowTheyWork.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconModulesWhatTheyAreHowTheyWork.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconModulesWhatTheyAreHowTheyWork.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconModulesWhatTheyAreHowTheyWork.htm
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 Data access pages - A data access page is a special type of Web page designed for 
viewing and working with data from the Internet or an intranet— data that is stored in 
Microsoft Access database or a Microsoft SQL Server database. The data access 
page may also include data from other sources, such as Microsoft Excel. 

In MS Access, data is stored once in one table, but can be viewed from multiple locations.  

When the data is updated in a Table, Query or Form, it is automatically updated everywhere 

it appears. 

2.1.2 Establishment of Ms Access database 

All Ms Access databases files are saved with extension .mdb.  A database should 

have a separate table for every major subject, such as Students records, Students 

grades, etc.. 

Production data or Treatment information. Data should not be duplicated in 

multiple tables. 

Microsoft Access provides three methods to create a database 

 Database Wizard (though easy, the wizard offers limited options to customize 

the database) 
 Using a template (This method works best if one can find and use a template 

that closely matches the specific requirements) 
 Creating a database directly (This is the most flexible method, but it 

requires one to define each database element separately). 
 

Basic Database Concept:  In studying MS Access, it is but necessary to understand 

some basic elements of a database before proceeding to it. 

 

Database Elements: 

 Data are raw facts.  It tells the truth about something; a person, a place, an object, 

etc.   

Example:    

 (1)  “Noel” is a data. “Noel” is my name, so it tells something 

about   a person.  “Noel” is a Name 

 

 

  (2)  “Male” is Noel’s gender.  So it tells something about “Noel”.  

Noel is Male. 

 

 Information is a collection of data (raw facts) which is contained in 1 file (table in 

Access)    

Name 

Noel 

Gender 

Male 

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconDataAccessPagesWhatTheyAreHowTheyWorkDT.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acconDataAccessPagesWhatTheyAreHowTheyWorkDT.htm
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Example: 

IDNumber LName   FName Mname Gender Bday Address 

MOE-0001 Cuevas Noel Pancho Male 11-05-

1978 

Aratkilo 

     (this is an information about a person named “Noel”) 

 

Example of a table (file): 

I Number Lame   FName Mname Gender Bday Address 

MOE-0001 Cuevas Noel Pancho Male 11-05-1978 Aratkilo 

MOE-0002 Panganiban Mark Perez Male 11-05-1978 Piasa 

MOE-0003 Cerna  Patrick Santos Male 11-05-1978 Aratkilo 

MOE-0004 Hipolito Valder Cruz Male 11-05-1978 Sidiskilo 

MOE-0005 Ohmy Diana Antonio Female 11-05-1978 Aratkilo 

…       

 

2.1.3 Naming Convention 

Is manner of naming files and variables?  Having a poor naming convention can only 

add confusion, so it's important that you start with a good scheme, and think about 

what the scheme will mean to you.  Here are the three things to consider in establishing 

a naming convention:         

1. Does my convention make sense to me?   

 Is must be simple and understandable to you. 

2. Will my convention make sense to other people?  
 Time will come that other people will look into your database program, so they 

must able to understand it. 

3. Can I be consistent in implementing and enforcing my convention?  
 All throughout my database work, your naming convention must not change. 

General  

Here are some basic simple rules when it comes to the name of any object in a 

database (including the name of the database itself):  

 

 Do not use spaces in object names. It might seem tempting and cute to have 
a view named "Sales By Quarter," but this is a nightmare to deal with 
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programmatically. Instead write it as “SalesByQuarter” or “SalesByQtr” or 
“QtrlySales” 
 

 Avoid using reserved words.  This is easier said than done, as there is a very 
large list of current and future reserved words to check against. Example: do not 

name your file as “Date” because “Date” is a reserve word in Ms Access. 
 

 Do not use dashes in database names.  Dash “-“ was often recognized by a 
computer as an operator (subtraction), so instead of naming your object as 

“Quarterly-Sales” better name it as QuarterlySales” or better use underscore 
instead of a dash “Quarterly Sales”.  
 

 Start object names with a letter. I see table named "2005_Sales" and columns 
and columns named "1", "2," "3," and so on (to represent months).  Ms Access 
might treat it as a number and not as a filename. 
 

 Keep names short but meaningful.  This is self-explanatory and fairly logical, 
"SlQ" is too short.  “SalesFiguresForCompanyByFiscalQuarter" is just silly.     
 

 Use sensible case.   There is little worse than going through a database schema 
where all the table names are in ALL CAPS.  It’s like Ms Access is yelling at you! 

Likewise, trying to read a procedure name like "getallarticlestatisticsbyweek" 
could drive some people to drink. I like camel-/Pascal-casing or using 
underscores, leaning toward the former in most cases: GetArticleStatsByWeek or 

getArticleStats_ByWeek. 
 

 Avoid Hungarian notation. The name of the object should make it pretty 

obvious what type of data it contains, and if for some reason it does not, then 
there is always the metadata tables and/or the documentation you should have 
written when designing the system. Using datatype-style prefixes for columns like 

Contacted (integer) and VEmail (varchar) not only make the column names 
harder to read, they also make them less flexible.  

The computer system has a computer and a screen. Each will have anon button and you will 

usually need to turn on both to be able to access the computer. The on button for the 

computer is usually on the front. If the lights on the box are on it means that the computer is 

operating. If there are no lights on the computer push the on button and various lights on the 

computer should show. 

 The computer will start or boot and it will perform a self-test to check that all of the 

parts of the computer are functioning. 

 The computer will then load the operating system. This is the first program that is 

loaded and it works with the other programs that we are going to load to show the 

image on the screen, save files, print, and other functions. 

Log-On Screen 
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 When the computer has completed its testing you will be presented with a log-in 

screen which will ask for a username and a password. The username will be unique 

and issued by your employer and will usually conform to a set of business rules to 

ensure there is consistency within the business.  

 Your password will follow a set of rules determined by the business. 

 Open and operate the relevant programs to use for our purpose. Example if you want 

to use MS-word you should open the word access.   

o Each program creates a file so the data can be recalled and edited as needed. 

Each program stores the data of the file in a different method or location in the 

file. For example a word file will store the language of the file within the file but 

a different program will store the same data but in a different place within the 

file. It is therefore important to know which program created the file. 

o Click on Start and then click on All Programs. Find the Microsoft® Office group. 

o Click on Microsoft Office Word and this will launch Word.  
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 Click on the file that is required and it will open in Word for editing in the corner of the dialogue 

box that filters the type of files that are shown. 

 An alternate approach to opening a file is to locate the file and open it directly, rather than 

using the creating program. 

 Click Start and then click Computer. 
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Access computer-based data 

   Use computer features to access a range of data or information 

 File Search 

 If you know the name of the file, or part of it, and you are not sure where the file is located on 

the disk you can search for the file.  

 Click Start and the Search Box will appear. 
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Enter the name of a file and Windows will search the disk and show a list of all files that 

match the criteria. When you have found the file click on the file and the parent application 

will load and open the file for viewing or editing. 

Searching From Computer 

Click Start>Computer.  In the top corner is the search box.  You can enter the name of the 

file or the partial name and Windows will search for the file.  Once you have found the file,  

double click and the program will launch and open the file for editing or searching.  
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below.  

1. ___________ is a database management tool that enables one to store relevant 

data(5points) 

A) MS access 

B) Microsoft of word 

C) Microsoft of power point 

D) Microsoft of excel 

2. Which one of the following is not Database Elements(5points) 
A) Data 

B) Information  

C) MS access 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5-10 points          Unsatisfactory - below 5 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-3 Entering relevant workplace data 

          2.3   Entering relevant workplace data 

2.3.1 Creating a database object table 

Creating DB Tables  

Recently, we define it as a file but technically, it was defined as a container or a worksheet-

like container where the collection of data has been stored. 

Before we proceed to creating your first table, we need to know first the basic components of 

a table: 

o Meta Data – Database Structure 

o Field – Column – Data 

o Fieldname 

o Record - Row - Information 

Metadata – is a “data about data” or synonymously called table structure that defines what 

type of data your data is?   

Given these data: 

(1) “Noel” which is a firstname, we can say that it composes of texts, so we define the 

firstname to accept text only thus it accepts the value “Noel” 

(2) Supposed that “21” is the Age of Noel, then we will define Age as a number, specifically 

an Integer so it will only accept a value which is an integer.Thus it gave a table structure of: 

Field Name   Data Type 

Firstname  Text 

Age   Integer 

Which only means to say that you cannot enter a number value in the Firstname field, 

likewise you cannot enter a text value to the Age field?  In that case, entering a number 
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1 Record 

Row 

Record 

value to a Firstname field would treat it as text.  Ex: Noel23. And cannot be used for 

computation. 

Field – Every column in a table represents a field by which data has been stored. 

Field name – This refers to the name of every field. 

Records – Every row in a table represents a record, which is a collection of 

meaningful data.   

Example of a table: Table name:  Students Table  

       7 columns = 7 fields 

 

 

 

            Field names 

 

     “MOE-0001” is the data for IDNumber field.  And IDNumber is a fieldname for that data. 

 

MOE-0001 Cuevas Noel Pancho Male 11-05-

1978 

Aratkilo 

IDNumber LName   FName Mname Gender Bday Address 

MOE-0001 Cuevas Noel Pancho Male 11-05-1978 Aratkilo 

MOE-0002 Panganiban Mark Perez Male 11-05-1978 Piasa 

MOE-0003 Cerna  Patrick Santos Male 11-05-1978 Aratkilo 

MOE-0004 Hipolito Valder Cruz Male 11-05-1978 Sidiskilo 

MOE-0005 Ohmy Diana Antonio Female 11-05-1978 Aratkilo 

…       
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1 Row gives an information.  It tells that  Noel Pancho Cuevas is a Male whose 

birthday is on 11-05-1978 and who lives in Aratkilo.   

 

Data Types 

 

 

 

 

 

When creating a table, one will need to specify what kinds of data are to be stored in this 

field. 

The different kinds of Ms Access 2003 data types are:  

 Text: allows for the storage of any kind of data, characters, digits and special 

characters. It has a defect length of 50 characters with a maximum length of 255. It is 

normally used to store data such as names, addresses, or any number not used in 

calculations, like telephone numbers or zip codes. 

 

 Memo: is used for texts of more than 255 characters such as comments or 

explanations. It has a maximum length of 65.536 characters. Access recommends that 

to store formatted text or large documents, rather to create an OLE Object field than a 

Memo field. In Access2003 it is possible to arrange or group in a Memo field, but Access 

only uses the first 255 characters when it arranges or groups in a Memo field. 

 Number: for numerical data used in mathematical calculations. Within the number 

type we are able to specify the size property of the field. The types Byte, Integer and 

Long Integer allow the storage of numbers without decimals; the types Single, Double 

and Decimal allow decimals; the type Replication ID is used for autonumerical codes in 

replication databases. 
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 Date/Time: for the introduction of date and time from the year 100 to 9999. 

 Currency: For monetary values and numerical data used in mathematical calculations 

in which the data involved contains between one and four decimals. The accuracy is up 

to 15 digits to the left of the decimal separator and up to 4 digits to the right of the same. 

Access recommends the use of Currency type to avoid the rounding off of 

numbers in calculus. A Currency field has an accuracy of up to 15 digits to the 

left of the decimal separator and 4 digits to the right. A Currency field occupies 

8 bytes of space on disc. 

 Autonumber: a unique sequential number (increasing one by one) that Access 

assigns every time it adds a new record to a table. Autonumber fields cannot be 

updated. 

 

 Yes/No: Yes and No values, and fields that contain one of two values (Yes/No, 

True/False or Activated/Deactivated). 

 

 OLE Object: an object such as a Microsoft Excel spreadsheet, a Microsoft Word 

document, graphics, images, sounds, or other binaries. 

 

 Hyperlink: text or a combination of text and numbers stored as text and used as a 

hyperlink address. A Hiperlink is a text or graphic that you click to go to a file, a location 

in a file, a web page on the Internet, or a web page on an intranet. 

Tables may be created by either: 

 Table wizard 

 Design view 

 

Creating Tables using design view 

Creation of a table by design view is a user customized way of making data storage 

tables 

Each field in the design view of a table corresponds to a column in the datasheet view of a 

table. 
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Designing a table involves: 

 

 Entering unique names of the columns of the table in the “field name” column of the 

design view. Names of fields and objects in Microsoft Access can be up to 64 characters 

long. They can include any combination of letters, numbers, spaces, and special characters 

except a period (.), an exclamation point (!), an accent grave (`), and brackets ([ ]). They also 

can't begin with leading spaces 

Primary Key is the unique identification of one record.  It will not allow a duplication of the Primary 

Key thus make it unique.  Define a Primary Key field (You don't have to define a primary key, but it's 

usually a good idea. If you don't define a primary key, Microsoft Access asks if you want Access to 

create one for you when you save the table) 

Retrieving Information 

Queries 

A query is a derived item in the database meant to answer specific questions that relate to 

the information in the database. Queries are handy during data processing. 

To find and retrieve just the data that meets conditions that you specify, including data 

from multiple tables, create a query. A query can also update or delete multiple records at 

the same time, and perform predefined or custom calculations on your data. 

A query requests data from the database. At its simplest, a query merely fetches all data 

from a single table. But as you create more complex (and more typical) queries, you can 

assemble exactly the data you want (i.e. unique sets of data that you require at any given 

time). 

Queries can also be used to execute mathematical and logical functions to obtain certain 

information in the database. 

Queries are derived from and linked to tables or other queries. (Due to these linkages, 

they tend to largely inflate the size of the database and should thus only be used to execute 

the intended functions, and stored only if updated information is to be retrieved) 
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There are various types of queries for different uses but for this session we will just focus on 

the Select queries: 

 Select queries - A select query is the most common type of query. It retrieves data from 

one or more tables and displays the results in a datasheet where you can update the 

records (with some restrictions). You can also use a select query to group records and 

calculate sums, counts, averages, and other types of totals. 

 Parameter queries - A parameter query is a query that when run displays its own dialog 

box prompting you for information, such as criteria for retrieving records or a value you 

want to insert in a field. You can design the query to prompt you for more than one piece 

of information; for example, you can design it to prompt you for two dates. Access can 

then retrieve all records that fall between those two dates. Parameter queries are also 

handy when used as the basis for forms, reports, and data access pages. For example, 

you can create a monthly earnings report based on a parameter query. When you print 

the report, Access displays a dialog box asking for the month that you want the report to 

cover. You enter a month and Access prints the appropriate report 

 Crosstab queries - You use crosstab queries to calculate and restructure data for easier 

analysis of your data. Crosstab queries calculate a sum, average, count, or other type of 

total for data that is grouped by two types of information— one down the left side of the 

datasheet and another across the top. 

 Action queries - An action query is a query that makes changes to or moves many 

records in just one operation. There are four types of action queries:  

 Delete Queries    A delete query deletes a group of records from one or more tables. For 

example, you could use a delete query to remove products that are discontinued or for 

which there are no orders. With delete queries, you always delete entire records, not just 

selected fields within records.  

 Update Queries    An update query makes global changes to a group of records in one 

or more tables. For example, you can raise prices by 10 percent for all dairy products, or 

you can raise salaries by 5 percent for the people within a certain job category. With an 

update query, you can change data in existing tables. 

 Append Queries    An append query adds a group of records from one or more tables to 

the end of one or more tables. For example, suppose that you acquire some new 

customers and a database containing a table of information on those customers. To avoid 

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
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typing all this information into your own database, you'd like to append it to your 

Customers table. 

 Make-Table Queries    A make-table query creates a new table from all or part of the 

data in one or more tables. Make-table queries are helpful for creating a table to export to 

other Microsoft Access databases or a history table that contains old records.  

Note: delete query should not be used unless one surely will not require the information to 

be deleted. To run a simple Select query: In the Database window, click Queries under 

Objects. Click the query you want to open. Click Open on the Database window toolbar. 

Note: To stop a query in progress (after you start it), press “CTRL+BREAK” 

Caution: It's a good idea to make a copy of the data you are changing or moving in an 

action query, in case you need to restore the data to its original state after running the 

action query 

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
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  There are different types of data from different working area. Such as:- 

 Human resource /employee data 

 Different reports and letters from different sides 

 Different statistical data 

 Hydrological and meteorological data etc. 

 Operators should inter the required data using appropriate computer system, such as 

Mc-excel, Mc-word, access etc. 

 To inter the data we should open the appropriate selected program. 

 After interring the data we should save the file in appropriate given name and space. It 

helps to easily retrieve the document and we can edit the data. 

 Exercise 1.  Please enter your personal information in your group. The data should 

include your name, Id No. , level, academic year, etc in Ms-excel and you should save 

the file in your appropriate space that you have easily accessible to open and edit it. 

 Exercise 2. Please prepare your once bibliography from the group and save it like the 

above one in Ms- Word.  
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below.  

1. Which one of the following is not the basic components of a table (5point)   
A) Meta Data – Database Structure 

B) Field – Column – Data 

C) data 

D) Record - Row – Information 

2. Which one of the following is not MS Access 2003 data types (5point)   

A) Text 
B) Memo 
C) Number 
D) Record - Row – Information 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5-10 points    Unsatisfactory - below 5 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-3 Producing Basic reports 

 

 3.3 Basic reports are produced as required 

   3.3.1 Creating Report 

Reports provide a means of organizing and summarizing data. Reports are often used to 

present an overview highlighting main points and trends. A report can be a simple list, a 

status report or a monthly production report. With reports, one can prepare: 

 Mailing labels for various producers 

 Produce a directory 

 Prepare invoices 

 Present data summaries. 

A report is made from the data available. There are several ways of preparing a report: 

 Auto Report: the quickest way to create a report, but gives least control over the 

report's  

Structure and appearance. This automatically contains all the fields in its data source, 

whether table or query. 

• Report Wizard: asks you questions and creates a report based on your answers. The 

Report Wizard asks which tables or queries the report will be based on, and which fields to 

use from those data sources. It also asks whether the data is to be grouped, and how it 

should be sorted and summarized. 

• Creating a Report in Design view: Gives one control, right from the start. Design view 

provides you with a toolbox from which you drag selected controls and arrange them on a 

grid.  To see the report as it will appear when printed, it should be viewed in Print Preview.  

Different properties may be set for a report, to change how it is viewed or printed. 

For example, a report's Page Header property determines whether the page header is 

printed on the page that begins with the Report Header. 

To view or change a report's properties, just double-click the report selector where the 

rulers meet. 
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To see more details about a property, click that property and then press F1. 

To view a control's properties, double-click the control 

 The activities that perform in the working area should be recorded, reported and 

documented. 

 The document /reported data may prepare in different form or system accordingly. 

(Word, excel, access, using different software or systems). 

 

 

 

 Exercise 3. Please prepare and report today's lesson. The report should contain: 

 objectives 

 Content  

 Method 

 Activities performed by teacher and students etc. 
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Save it then close it.  To preview your report, double click on the report file R_ITStudentsList. 

Note:  to run the report, you would need to create a button in a form embedded with macro 

code or VBA code that once click, it would execute opening or printing of a report.  

           Ensure integrity of software systems, data and information 

 Each program creates a file so the data can be recalled and edited as needed. Each 

program stores the data of the file in a different method or location in the file. For 

example a word file will store the language of the file within the file but a different 

program will store the same data but in a different place within the file. It is therefore 

important to know which program created the file. 

 Click on Start and then click on All Programs. Find the Microsoft office group. 

 Click on Microsoft Office Word and this will launch Word or click on the other program 

(office) that is appropriate for your work and the program that call out will launch. 

 To be able to edit a file it must be loaded into Word.  

 Click File>Open and the Open Dialogue box will appear. 

 Click on the file that is required and it will open in Word for editing in the corner of the 

dialogue box that filters the type of files that are shown. 

 Close Word by selecting File and then Exit Word. 

 As an alternative to the File>Open approach there are two other options. One of these 

is the use of a shortcut key. Rather than use the mouse by simultaneously pressing a 

combination of keys the same result can be achieved. The keys for Open File are Ctrl- 

This key combination works in many of the Office suite of programs.  

            Identify and open correct file 

           Finding a File 

 An alternate approach to opening a file is to locate the file and open it directly, rather 

than using the creating program. 

 Click Start and then click Computer. 
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 Computer 

 Files can be stored on various mediums. In the graphic you can see there are several 

drives, all with a letter and a colon ":". 

 Click Start and then Computer to open Computer or Windows Explorer.  By clicking 

you can navigate to the folder that stores the required file. 

 Storage Medium 

 Storage devices are given with letter name and a colon, for example, A:, B:, C:, D:, E: 

up to drive Z:. There are three types of storage: fixed, removable, and network. The 

fixed storage remains in the computer and cannot be easily removed. It contains the 

programs that are used to edit and change data and also store the data and is usually 

called drive C:  

Use computer features to access a range of  

data or information 

File Search 

 If you know the name of the file, or part of it, and you are not sure where the file is 

located on the disk you can search for the file. Click Start and the Search Box will 

appear. 

 Enter the name of a file and Windows will search the disk and show a list of all files 

that match the criteria. When you have found the file click on the file and the parent 

application will load and open the file for viewing or editing. 

Searching From Computer 

 Click Start>Computer. In the top corner is the search box. You can enter the name of 

the file or the partial name and Windows will search for the file. Once you have found 

the file, double click and the program will launch and open the file for editing or 

searching 
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. 

1. Which one of the following is not ways of preparing a report? (5 points) 

A) Creating a Report in Design view 

B) Report Wizard 

C) Auto Report 

D) Data 

 

 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2.5-5 points            Unsatisfactory - below 2.5points  

You can ask you teacher for the copy of the correct answers. 
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Operation Sheet -1 

Creating a data access pages 
 

Creating Data Access Pages 

 

 There were 3 ways to create a Data Access Page 

1. Create data access page in Design view 

2. Create data access page by using Wizard 

3. Edit Web page that already exist 

 

Just click on the Pages, and then double-click on Create data access page by 

using Wizard.   

 

 Follow these steps in creating your first Data Access Page: 

1. Choose T_StudentsList table on the Tables/Queries drop-down arrow. 

2. Select all fields by clicking the double greater than button just like what you 

did in the form wizard.  Click next after. 
3. On the level grouping, click on Course Field then click the greater than button.  

By doing this, you are grouping the students’ records according course.   

4. On sort records, click on the Last name then set its order as Ascending then 

click next. 

5. Save your page as P_ITStudentsList 

6. Click on Modify the page’s design then click Finish. 

7. It would then launch the Data Access Page that you have just created in 

design view as shown below. 
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To view the data access page, Click on Pages then double-click the data access page 

file that you have just created.  

Try to explore more the data access pages. 

 

Operation Sheet -2 

Creating a report 

 

       Creating Reports 

There were 2 ways to create a Report 

1. Create Report in design view 

2. Create Report by using wizard 

Just click on the Reports, and then double-click on Create report by using wizard.  Follow 

the series of steps below in creating an IT plumbing installation student List:  

1. Choose Q_ITStudentsList query on the Tables/Queries drop-down arrow. 

2. Select all fields by clicking the double greater than button just like what you 

did in the form wizard.  Click next after. 

3. Just skip the level grouping by clicking Next.  

4. On sort records, click on the Last name then set its order as Ascending then click 

next. 

5. Choose the default layout which is tabular and the default orientation as portrait then  

Click next.  

6. Click the default style as formal then choose the Modify reports in design view    

7. Save your report as R_ ITStudentsList 

8. Click on the Modify the reports design then click Finish. 

9. It would then launch the Report in Design View as shown below. 
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                              Learning Guide # 68 

Unit of Competence: use computerized system 
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Instruction  Learning guide 68 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics:  

 Checking, editing, saving, printing and filing work 

 Exiting  and closing  down the system 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

Learning Instructions:  

 Check editing, saving, printing and filing work 

 Exit and closing down the system 

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1and Sheet 2”. 

4. Accomplish the “Self-check 1and Self-check 2” in page -55and 59respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation Sheet 1, 

Operation Sheet 2 and Operation Sheet 3 ” in page -60. 

6. Do the “LAP test” in page – 60 (if you are ready).  
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Information Sheet-1 Checking , editing , saving , printing  and filing work 

 

3.1 Editing Documents  

3.1.2 Cut and Paste  

You can use Word's Cut feature to remove information from a document.  You can use the 

Paste feature to place the information you cut anywhere in the same or another document.   

In other words, you can move information from one place in a document to another place in 

the same or different document by using the Cut and Paste features. The Office Clipboard is 

a storage area. When you cut, Word stores the data you cut on the Clipboard. You can paste 

the information that is stored on the Clipboard as often as you like cut with the Ribbon 

    Print a document or file 

The quickest way to print a document or file is to print using Windows. You don't have to 

open any programs or change any settings. 

 Right-click the file you want to print, and then click Print. 

Windows will launch the program that created the file and send it to your default 

printer 

 Type the following:  

. I am content where I am. I want to move  

Select "I want to move. "  

Choose the Home tab.  

Click the Cut button   in the Clipboard group. Word cuts the text you selected and places it on 

the Clipboard. Your text should now read:  

"I am content where I am.“ 

Paste with the Ribbon  

Place the cursor after the period in the sentence "I am content where I am."  

Press the spacebar to leave a space.  

Choose the Home tab.  

Click the Paste button   in the Clipboard group. Word pastes the text on the Clipboard. Your 

text should now read:  

"I am content where I am. I want to move."  

Alternate Method—Cut with a Context Menu  
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Type the following:  

I want to move. I am content where I am.  

Select "I want to move. "  

Right-click. The Mini toolbar and a context menu appear. 

Click cut on the menu. Your text should now read:  

"I am content where I am."  

 Alternate Method—Paste with a Context Menu  

 Place the cursor after the period in the sentence  

"I am content where I am."  

 Press the spacebar to leave a space.  

 Right-click. A Mini toolbar and a context menu appear.  

 Click Paste. Your text should now read:  

"I am content where I am. I want to move."  

  Alternate Method—Cut with a Context Menu  

 Type the following:  

I want to move. I am content where I am.  

 Select "I want to move. "  

 Right-click. The Mini toolbar and a context menu appear. 

 Click Cut on the menu. Your text should now read:  

"I am content where I am."  

 Alternate Method—Paste with a Context Menu  

 Place the cursor after the period in the sentence  

"I am content where I am."  

 Press the spacebar to leave a space.  

 Right-click. A Mini toolbar and a context menu appear.  

 Click Paste. Your text should now read:  

"I am content where I am. I want to move."  

 Alternate Method—Cut with Keys  

 Type the following:  

I want to move. I am content where I am.  

 Select "I want to move."  
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 Press Ctrl+x.  

 Your text should now read:  

“I am content where I am."  

 Alternate Method—Paste with Keys  

 Place the cursor after the period in the sentence: "I am content where I am."  

 Press the spacebar to leave a space.  

 Press Ctrl+v.  

Your text should now read:  

"I am content where I am. I want to move 

     Save document  

When you save a file, you can save it to a folder on your hard disk drive, a network location, 

disk, CD, the desktop, or another storage location. 

 

SAVE is the process of writing data to a storage medium, such as a floppy disk, CD-R, USB 

flash drive, or hard drive. The Save option is found in almost all programs commonly under 

the "File" drop-down menu. When clicking the Save option, the file will be saved as its 

previous name. However, if the file is new, the program will ask the user to name the file and 

where to save the file. 

Tip  

 You may also you use the Save As option to make a copy of the file you've already 

created or rename it. 

 Use the keyboard shortcut key Ctrl+S or Control+S on a PC to save a document or 

file at any time. 

A program saves files to the destination of your choice. The program may default to a 

specific folder (e.g., My Documents) or may use the last used location as the starting place 

to save a file. You can browse to the folder or drive you want to save the file or use the 

default location 

https://www.computerhope.com/jargon/s/stordevi.htm
https://www.computerhope.com/jargon/f/floppydi.htm
https://www.computerhope.com/jargon/c/cdr.htm
https://www.computerhope.com/jargon/j/jumpdriv.htm
https://www.computerhope.com/jargon/j/jumpdriv.htm
https://www.computerhope.com/jargon/h/harddriv.htm
https://www.computerhope.com/jargon/m/menu.htm
https://www.computerhope.com/jargon/k/keyboard-shortcut.htm
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The main difference between Save and Save As is that Save helps to update the lastly 

preserved file with the latest content while Save As helps to store a new file or to store an 

existing file to a new location with the same name or a different name. 

 

While working on a document or another file in almost every program, pressing Ctrl+S saves 

that file. Use this shortcut key frequently if you're working on anything important in case of an 

error, lost power, or any other issues that causes you to lose any work since the last save. 

While you're working with a file in a program, you should save it frequently to avoid losing 

data unexpectedly due to a power failure or other problems. 

 

        What does the save icon look like? 

It is up to the developer of the program to decide how the save icon appears. However, to 

keep the familiarity of past computer programs, the save icon often looks like a floppy disk, 

which should resemble one of the icons shown below. 

 

 

Why do we need to save files? 

Unless the program you are using automatically saves as you are working, if a file is not 

saved it is lost. For example, if you are writing a book and power to your computer is lost, or 

the computer crashes anything that was typed written that was not saved is lost. 

 

mshelp://windows/?id=4c7a98ab-e99e-485d-ae81-28110bfe3b9c#gtmt_file_def
mshelp://windows/?id=9ada1558-de2c-46fa-b6f3-5330af66ac9b#gtmt_gls_application_def
https://www.computerhope.com/jargon/f/floppydi.htm
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3.2. File Extensions 

Files are identified by a short "extension" following a period at the end of their name. For 

example, ABC.JPG is a JPEG image, ABC.DOC is a Microsoft Word document file, and 

ABC.EXE is an executable application in Windows. Although extensions can be added to 

folder names, extensions are primarily a file convention 

3.3 File naming convention guide  

The most relevant reasons for adopting proper file naming conventions are:  

 A recognizable file name will ensure search engines will locate the file  

 A short file name will be properly displayed and backed up by the server  

 A file name without special characters and spaces will be displayed and interpreted 

correctly by all browsers. 

 

3.3.1. File Names Should be Meaningful  

Meaningful file names tend to be ranked higher by search engines. For example, by 

assigning the PAHO acronym to files at the beginning of the name we are ensuring higher 

ranking. PAHO is a brand, a recognizable name which has prestige among search engines. 

When dealing with files related to a specific health topic it will be useful to assign this topic to 

the file name, for example: paho-malaria-final.doc. 

 

3.3.2. File Names Should be Short and in Lowercase  

The maximum length for a file path is 255 characters. This full path of a file name includes 

the drive letter, colon, backslash, directories, sub-directories, filename, and extension; 

therefore, the amount of characters left for the file name is limited depending on where in the 

server structure it likes. We suggest using maximum of 25 characters for the file name. 

 

3.3.3. File Names Should not Contain Special  

Characters Avoid using special characters above all else. The following characters \ / : * ? " < 

> | [ ] & $ , . are considered special characters and are all used for specific tasks in an 

electronic environment; therefore, never use them as part of your file name. Also to be 

avoided in file names is the use of non-English language letters such as á, í, ñ, è, and õ. 

 To save the document with the same name click on the File Menu and then click 

Save. 
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 To save with a different name click File and then click save As and the dialogue box 

will appear. 

Saving the Spreadsheet 

 To save the sheet with the original click 'File' and then 'Save'. The spreadsheet will be 

automatically saved with the same filename. 

 To save with a different file name click 'File' and then 'Save As'. You will be presented 

with a dialogue box and you can navigate to the subdirectory where the file is to be 

saved.  

 Find the location, enter the filename and then click Save. 

 

 

 

 

Printinting from the word  
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   Document printing basics 

    What is printer and its uses? 

A printer is a device that accepts text and graphic output from a computer and 

transfers the information to paper, usually to standard size sheets of paper. A computer 

printer does not work until you install the included drivers and software.  

Print is the process of a computer transferring data to a computer printer and generating 

a hard copy of the electronic data being printed. 

Installed printer is a printer in which its software is installed in the computer and information 

can be printed directly from the computer. 

1.2. Types of printer 

The two most common types of printers are Impact Printers and Non-Impact Printers:- 

Impact Printers:- In this pins striking against a ribbon and paper to print the text. This 

mechanism is known as the electro-mechanical mechanism. 

Non-Impact Printers:- There printers use non-Impact technology such as ink-jet or laser 

technology. Their printers provide the better quality of O/P at higher speed. 

Following are some non-impacted printers. 

Ink-jet printers 

Laser printers 

 

1.3. Connection methods  

Connect the printer to the computer either using a USB cable, parallel port cable, or SCSI 

cable and then connect the power plug to a power outlet. Today, most all home computer 

printers are using a USB cable similar to the example picture. 

 

https://www.computerhope.com/jargon/p/printer.htm
https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/u/usb.htm
https://www.computerhope.com/jargon/p/paraport.htm
https://www.computerhope.com/jargon/s/scsi.htm
https://www.computerhope.com/jargon/s/scsi.htm
https://www.computerhope.com/jargon/c/cable.htm
https://www.computerhope.com/jargon/o/outlet.htm
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 There are three methods that can be used to print from word: the File Menu option, 

Printer icon, or the shortcut key Ctrl-P. 

 Open Personal_Computers.docx 

 Click File>Print and the print options page will occur. There is a preview of the current 

page shown on the right. 

 The 'copies' box allows you to specify the number of copies. 

 The printer allows you to change the printer as a business may have different printers 

for different situations 
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Printing from Excel 

 Excel does not paginate a document as Word does until printing. It is therefore 

important to check the page breaks before sending a document to the printer.  

 To determine the page breaks simply open the print options and then click 'Home' and 

Excel will show where the page breaks will occur.  

 The print preview in the Print Options will allow you to check that the page breaks are 

appropriate 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below.  

1. _____________ is the process of writing data to a storage medium.(5 points) 

A) Save 

B) Data 

C) File  

D) Storage 

3. Which one of the following are 

the two most common types of printers  (5 points) 

A) Impact Printers  

B)  Non-Impact Printers 

C) All  

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

Short Answer  

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5-10 points          Unsatisfactory - below 5 points  

You can ask you teacher for the copy of the correct answers. 

 

https://www.computerhope.com/jargon/s/stordevi.htm


 

 

Page 59 of 63 
 

Federal TVET Agency 
Author/Copyright  

Plumbing installation level-II 
Version -1 

October 2019 

 
 

 

Information sheet -2 Exiting  and closing  down the system 

 

3.2   Exiting and closing down the system 

 3.2.1 The document 

To close your document you have to options using close command and close button form 

title bar. 

 Again, by clicking 'File‟ and „Close', File will close.  

 Click the lower X at the top of the program and file will close the spreadsheet. 

 This will close the program. 

 A second approach is to click the File menu and then click Exit.  

When you’re finished working with a window or program, you can close it to remove it from 

the screen and computer’s memory. You can close any window or program by clicking its 

Close button, which appears in the upper-right corner of the window. 

 

 

Closing programs running in the background on your computer can free up system resources 

for your other programs. This can resolve problems where your system is running slowly or 

two programs are trying to use the same device. At this time it may be impossible to close 
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the programs so we must use another option: disable background programs on Windows 

from Task Manager. 

 

Below are visual examples of the Task Manager in Windows 2000, Windows 7, Windows 8, 

and Windows 10. 
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Warning: If you use the End Process feature to close a program, you will lose any unsaved 

data in that program. Avoid ending system processes if possible, and be cautious when 

terminating system processes: you may disable necessary components of your system. You 

may need to restart your computer to restore full functionality. 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below.  

1. How do you Exiting and closing down the system (10 points) 

 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

  

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5-10 points          Unsatisfactory - below 5 points  

You can ask you teacher for the copy of the correct answers. 
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No Name of trainer Qualification Region E-mail 

1 BELAY DEBEBE  Construction 

technology 

management  

Adis ababa  Belayyyen@gmail.com 

2 DERBABAW MULAW  Construction 

technology 

management  

Amahara Derbabawaa@gmail.com 

3 SEBLEWENGLE BEKEL  Construction 

technology 

management  

Oromia   

4 WENDESEN ABERA  Construction 

technology 

management  

Dire -dawa sunshikur@gmail.com  

5 ABDIKADIR ISMAIL Construction 

technology 

management  

Somali Hirsi1380@gmail.com  

6 DAWIT TEFERA  Construction 

technology 

management  

Harari   

7 REMEDAN MOHAMMED Construction 

technology 

management  

Harari ramseymoha80@gmail.com 

 

mailto:sunshikur@gmail.com
mailto:Hirsi1380@gmail.com

